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はじめにはじめにはじめにはじめに 

リリース・ノートの構成についてリリース・ノートの構成についてリリース・ノートの構成についてリリース・ノートの構成について 

このリリース・ノートの第 2 章は英語リリース・ノートの翻訳版です。日本語環境固有の情

報については、第 1 章を参照してください。 

マニュアルに記載されている名称についてマニュアルに記載されている名称についてマニュアルに記載されている名称についてマニュアルに記載されている名称について 

「Oracle 9iFS」および「9iFS」は、Oracle Internet File System の略称です。また、Oracle9i 関
連マニュアルは、英語版を翻訳しているため、マニュアル内で参照されている情報には、日

本では提供されていないものも含まれます。 

� インターネット URL 

� マニュアル名 

� ソフトウェア名 

英語オンライン・マニュアルの扱いについて英語オンライン・マニュアルの扱いについて英語オンライン・マニュアルの扱いについて英語オンライン・マニュアルの扱いについて 

CD 媒体上の英語のマニュアルと同一のマニュアルが日本語で提供されている場合は、日本

語版を参照してください。 

最新情報の入手について最新情報の入手について最新情報の入手について最新情報の入手について 

日本オラクルでは、インターネット開発者向けのあらゆる技術リソースを、24 時間 365 日提

供するコミュニティ・サイト OTN-J（Oracle Technology Network Japan）を運営しています。

OTN-J では、最新の技術情報、オンライン・マニュアル、ソフトウェア・コンポーネントな

どを、無料で入手できます。 

http://otn.oracle.co.jp/ 
 

また、最新のセキュリティ情報については、次のサイトを参照してください。 

http://www.oracle.co.jp/news/security/ 

http://otn.oracle.co.jp/
http://www.oracle.co.jp/news/security/
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第第第第 1 章章章章  日本語環境での使用上の注意日本語環境での使用上の注意日本語環境での使用上の注意日本語環境での使用上の注意 

Linux ディストリビューションについてディストリビューションについてディストリビューションについてディストリビューションについて 

このリリースの Oracle Internet File System for Linux Intel のサポート対象 Linux ディストリビ

ューションは次のとおりです。 

� Red Hat Linux 7.1 

� MIRACLE LINUX V2.0 

動作要件について動作要件について動作要件について動作要件について 

第 2 章の「ハードウェア要件」の最小構成では、512MB の RAM と 1GB のスワップ領域と

記載されていますが、これは誤りです。最小構成でも 1GB 以上の RAM と 2GB 以上のスワ

ップ領域が必要です。 

Java ツールにおける日本語表示の問題についてツールにおける日本語表示の問題についてツールにおける日本語表示の問題についてツールにおける日本語表示の問題について 

Oracle 製品では、Sun 社より提供される Java Runtime Environment（JRE）を使用します。プ

ラットフォームに JRE が使用する日本語フォントが正しく設定されていない場合、JRE を使

用した Oracle 製品で日本語が正しく表示されないなどの問題が発生します。 

一般的なフォントの設定方法には、次のものがあげられます。 

� JRE で必要なフォントをインストールする 

� Xserver のフォント・マッピング設定機能を使用する 

� font.propertiesを変更する 

フォントの設定方法の詳細は、各プラットフォーム・ベンダーにお問い合せください。 

Oracle データベースについてデータベースについてデータベースについてデータベースについて 

このリリースの Oracle 9iFS がサポートする Oracle データベースは、Oracle9i データベース リ
リース 1（9.0.1）です。Oracle8i データベース リリース 8.1.7.2 はサポート対象外です。 
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システム・パッチについてシステム・パッチについてシステム・パッチについてシステム・パッチについて 

Oracle9i Database Patch Set Release R9.0.1.3 以上を適用した環境では、第 2 章の「システム・

パッチ」に記載されているパッチ 1859905 は適用しないでください。また、パッチ

glibc-2.2.2-53.i386.rpmは、日本でのサポート対象 Linux ディストリビューションで

は適用する必要はありません。 

Oracle9i Real Application Clusters についてについてについてについて 

Oracle9i Real Application Clusters を使用したクラスタ環境では、このリリースの Oracle 9iFS
の使用はサポート対象外です。 

全文検索機能（全文検索機能（全文検索機能（全文検索機能（Oracle Text）を使用する場合の注意）を使用する場合の注意）を使用する場合の注意）を使用する場合の注意 

Red Hat 系 Linux ディストリビューションにて Oracle Text を使用する場合、Oracle 9iFS をイ

ンストールする前に Oracle9i データベースにパッチを適用する必要があります。パッチの詳

細は、『Oracle9i for Linux Intel リリース・ノート』の第 1 章の「Red Hat 系 Linux ディストリ

ビューションでの INSO フィルターの使用について」を参照してください。 

クライアント・ソフトウェアについてクライアント・ソフトウェアについてクライアント・ソフトウェアについてクライアント・ソフトウェアについて 

Oracle 9iFS でサポートされるクライアント・ソフトウェアは、次に示す動作検証済ソフトウ

ェアとの互換の範囲内でのサポートとなります。これら以外のクライアント・ソフトウェア

で固有の問題が発生した場合は、サポート対象外となります。 

� Microsoft Windows 用 Web ブラウザ（HTTP および Web インタフェース用） 

� Microsoft Internet Explorer 5.0 以上 

� Netscape Communicator 4.72 以上（Netscape 6.x は、このリリースではサポートされ

ません） 

� Microsoft Windows オペレーティング・システム（Oracle 9iFS Windows ユーティリティ

および Web インタフェース用） 

� Windows NT 4.0 Workstation および Server（Service Pack 6 以上） 

� Windows 95 および 98  

� Windows 2000 Professional および Server 

� SMB アクセス 

� 前述の Windows オペレーティング・システムの Windows エクスプローラ 
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� FTP アクセス 

� 前述の Windows オペレーティング・システムの標準 FTP コマンド 

� Red Hat Linux 7.1 の標準 FTP コマンド 

� WebDAV アクセス 

� 前述の Windows オペレーティング・システムの Web フォルダ 

� NFS アクセス 

� Red Hat Linux 7.1 

コマンドライン・ユーティリティについてコマンドライン・ユーティリティについてコマンドライン・ユーティリティについてコマンドライン・ユーティリティについて 

このリリースの Oracle 9iFS では、Windows 95 および Windows 98 クライアントでのコマン

ドライン・ユーティリティの使用はサポート対象外です。 

電子メール・サーバー機能について電子メール・サーバー機能について電子メール・サーバー機能について電子メール・サーバー機能について 

このリリースの Oracle 9iFS では、IMAP4 および SMTP サーバー機能はサポート対象外です。 

旧リリースからのアップグレードについて旧リリースからのアップグレードについて旧リリースからのアップグレードについて旧リリースからのアップグレードについて 

OTN-J などで配布されていた旧リリースの Oracle Internet File System からのアップグレード

はサポート対象外です。旧リリースの Oracle Internet File System を使用している環境にこの

リリースをインストールする場合は、旧リリースを完全にアンインストールし、既存のデー

タベース・スキーマを再利用しないようにインストールしてください。 

Oracle 9iFS Portlet についてについてについてについて 

このリリースの Oracle 9iFS では、Oracle 9iFS Portlet はサポート対象外です。 

Oracle Universal Installer の「サマリー」ページについての「サマリー」ページについての「サマリー」ページについての「サマリー」ページについて 

日本語環境で Oracle Universal Installer を起動しているにもかかわらず、「サマリー」ページ

では製品の言語として「英語」と表示されます。これは表示の問題であり、実際は日本語が

インストールされます。 
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ドメイン起動時にドメイン起動時にドメイン起動時にドメイン起動時に Node.log に出力される例外についてに出力される例外についてに出力される例外についてに出力される例外について 

ドメインの起動時、$ORACLE_HOME/9ifs/log/Node.logに InterMediaAnnotatorAgent に関

する例外が出力されます。この問題は、キャプション・ブロック内に、IPTC-IIM のデータ

が含まれた形式の JPEG ファイルを格納する際に発生します。

$ORACLE_HOME/ord/Annotator/lib/descriptors/JpgParser.xmlの

ParameterValueを falseに設定することにより、例外は発生しなくなります。 

ユーザー名およびパスワードについてユーザー名およびパスワードについてユーザー名およびパスワードについてユーザー名およびパスワードについて 

Oracle 9iFSで登録するユーザー名とパスワードに日本語や全角文字を使用することはできま

せん。必ず半角英数字を使用してください。 

Oracle 9iFS Manager ヘルプの文字化けについてヘルプの文字化けについてヘルプの文字化けについてヘルプの文字化けについて 

Oracle 9iFS Manager を、ifsmgrコマンドを単独で使用して起動した場合、ヘルプの本文中

で文字化けが発生します。次のいずれかの方法で起動することにより、正常に表示されます。  

� oemappコマンドを使用して起動  

$ oemapp ifsmgr 
� Oracle Enterprise Manager コンソール（OMS を介した接続）から関連ツールとして起動 

Oracle 9iFS Manager の「検索」ダイアログ・ボックスについての「検索」ダイアログ・ボックスについての「検索」ダイアログ・ボックスについての「検索」ダイアログ・ボックスについて 

Oracle 9iFS Manager の「検索」ダイアログ・ボックスで、次の制限事項があります。 

� 検索を実行後、「閉じる」ボタンでダイアログ・ボックスを閉じることができません。

「閉じる」ボタンをクリックした後、「取消」ボタンをクリックすることにより、ダイ

アログ・ボックスを閉じることができます。 

� 「CREATEDATE」、「LASTMODIFYDATE」、「EXPIRATIONDATE」などの日付属

性を使用した検索は行えません。 

Web ブラウザのステータス･バーにおける文字化けについてブラウザのステータス･バーにおける文字化けについてブラウザのステータス･バーにおける文字化けについてブラウザのステータス･バーにおける文字化けについて 

Web インタフェースでファイル名に日本語が含まれたファイルをマウスで指した際、ブラウ

ザのステータス･バーに表示されるファイル名が文字化けします。これは UTF-8 文字コード

の文字列を正しく表示できないというブラウザ側の問題であり、Oracle 9iFS の動作には影響

ありません。 
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Web インタフェースのドラッグインタフェースのドラッグインタフェースのドラッグインタフェースのドラッグ&ドロップ用ウィンドウについてドロップ用ウィンドウについてドロップ用ウィンドウについてドロップ用ウィンドウについて 

Web インタフェースでファイルをドラッグ&ドロップでアップロードする際に表示されるウ

ィンドウは、ドロップ専用です。ウィンドウ内に表示されているファイルを操作することは

できません。 

Netscape 固有の制限事項について固有の制限事項について固有の制限事項について固有の制限事項について 

Oracle 9iFS の Web インタフェースを、Netscape Communicator を Web ブラウザとして使用し

た場合、次の制限事項があります。これらはスタイルシートや UTF-8 文字コードの処理にお

ける Netscape 側の問題に起因する制限です。 

� ヘルプ・ウィンドウ内で日本語文字列が正しく表示されない場合があります。この場合、

次のように設定を変更することで解消されます。 

1. 「編集」メニューから「設定」を選択します。 

2. カテゴリ欄の「表示」ツリーから「フォント」を選択します。 

3. 右側の設定項目で「ドキュメント指定のフォントを無視して、設定したフォントを

使用」を選択します。 

4. 「OK」をクリックして設定を保存し、再度アクセスします。 

� ウィンドウの大きさに関わらず、テキスト・ラベルが不正な位置で折り返して表示され

る場合があります。 

� アイコンをマウスで指した際に表示されるバルーン・ヘルプ内で、文字化けや不正な文

字揃えが発生します。 

� ドラッグ＆ドロップでファイルをアップロードする際に表示されるウィンドウ内で、日

本語オブジェクト名が文字化けします。 

� 参照してファイルをアップロードする際、ファイル名に日本語が含まれたファイルのア

ップロードはできません。 

� ドラッグ＆ドロップで、フォルダ単位のアップロードはできません。 

� ファイル名に日本語が含まれたファイルを右クリックして保存する際、「リンクを名前

を付けて保存...」で表示されるダイアログ・ボックス内のファイル名が文字化けします。 

� 検索フィールドが正しく表示されない場合があります。 
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デフォルトのキャラクタ・セット設定についてデフォルトのキャラクタ・セット設定についてデフォルトのキャラクタ・セット設定についてデフォルトのキャラクタ・セット設定について 

Web インタフェースでファイル名に日本語が含まれたファイルを正しく操作するために、

Oracle 9iFS サーバーのデフォルト・キャラクタ・セットとクライアント・マシンのキャラク

タ・セットを一致させる必要があります。デフォルト・キャラクタ・セットの値は次のいず

れかで設定または変更可能です。 

� Oracle 9iFS Configuration Assistant の「ドキュメントの内容」ページでの「キャラクタ･

セット」 

� Oracle 9iFS Manager の「管理者のタスク」から「サービス構成」を選択して表示される

LargeServiceConfiguration、MediumServiceConfiguration および SmallServiceConfiguration
の IFS.SERVICE.DefaultCharacterSetプロパティ 

デフォルト・キャラクタ・セットについては、『Oracle Internet File System for UNIX Systems
セットアップおよび管理ガイド』を参照してください。 

Oracle Enterprise Manager コンソールからのコンソールからのコンソールからのコンソールからの HTTP ノードの起動ノードの起動ノードの起動ノードの起動/停止に停止に停止に停止に 
ついてついてついてついて 

Oracle 9iFS の初期状態では、ifsJservctlコマンドを使用して、Oracle 9iFS 専用の Jserv プ

ロセスで HTTP ノードを実行する設定になっています。Oracle Enterprise Manager コンソール

から HTTP ノードの起動および停止を行う場合、Oracle HTTP Server の標準 Jserv プロセスを

使用するように設定を変更する必要があります。 

設定の変更方法の詳細は、『Oracle Internet File System for UNIX Systems インストレーショ

ン・ガイド』の第 4 章の「デフォルトの Jserv プロセスでの実行」を参照してください。 

ifsmigratepasswords の入力パラメータについての入力パラメータについての入力パラメータについての入力パラメータについて 

『Oracle Internet File System for UNIX Systems セットアップおよび管理ガイド』の第 7 章の「ユ

ーザーの資格証明情報の移行」で説明のある、ifsmigratepasswordsで表示される「パス

ワードの移行」画面での入力パラメータについての補足情報です。 

「パスワードの移行」画面の「スキーマ」フィールドおよび「Where 句」フィールドでは、

次のように入力してください。 

� スキーマ:  「発信元データベース情報」および「宛先データベース情報」セクション

の各スキーマには、名前の後に$CMを付けた形式でスキーマ名を入力してください。 

たとえば、スキーマ名が IFSSYSの場合、「IFSSYS$CM」と入力します。 

� Where 句:  「発信元データベース情報」セクションの Where 句には、資格証明を移行

するユーザーの問合せ条件を入力してください。 
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たとえば、「where DISTINGUISHEDNAME = '<ユーザー名>'」 
または、  「where DISTINGUISHEDNAME like '<ユーザー名%>'」 
と入力します。 

Quick Tour についてについてについてについて 

Web インタフェースのログイン画面から起動可能な Quick Tour は英語版です。日本語版

Quick Tour は、パッケージに同梱されている「Oracle9i Database Release 1（9.0.1）プラットフ

ォーム共通Update CD-ROM」内に用意されています。Webインタフェースから日本語版Quick 
Tour を起動するには、Oracle 9iFS 上の英語版 Quick Tour ファイルを日本語版 Quick Tour フ
ァイルに置き換える必要があります。 

例:  SMB プロトコルを使用して置き換える場合 

1. Windows エクスプローラで X ドライブに Oracle 9iFS 上の root フォルダを割り当て

ます。 

2. 「Oracle9i Database Release 1（9.0.1）プラットフォーム共通 Update CD-ROM」を

CD-ROM ドライブ（E:）に挿入します。 

3. Windows のコマンド・プロンプトで、次のように HTML ファイルを上書きコピー

します。 

C:¥>copy "E:¥9iFS¥Quick Tour¥*.*" "X:¥doc¥9ifs¥Quick Tour¥" 
4. Windows のコマンド・プロンプトで、次のようにイメージ・ファイルを上書きコ

ピーします。 

C:¥>copy "E:¥9iFS¥Quick Tour¥Graphics¥*.*" "X:¥doc¥9ifs¥ 
Quick Tour¥Graphics¥" 

Oracle 9iFS SDK サンプル・プログラムについてサンプル・プログラムについてサンプル・プログラムについてサンプル・プログラムについて 

Oracle 9iFS SDK では、Oracle 9iFS Java API の習得およびカスタム・アプリケーションの開発

に役立つサンプル・プログラムが多数提供されています。製品に標準で付属しているサンプ

ル・プログラムには一部不具合があるため、サンプル・プログラムの修正版が「Oracle9i 
Database Release 1（9.0.1）プラットフォーム共通 Update CD-ROM」で提供されています。サ

ンプル・プログラムを使用する場合は必ず、すでにインストールされているものと置き換え

てください。 

oracle.ifs.adk.mail パッケージについてパッケージについてパッケージについてパッケージについて 

このリリースの Oracle 9iFS では、oracle.ifs.adk.mailパッケージに含まれる ifsStore
クラスおよび ifsTransportクラスはサポート対象外です。 
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オブジェクト名に関する制限についてオブジェクト名に関する制限についてオブジェクト名に関する制限についてオブジェクト名に関する制限について 

クラスや属性の名前に、日本語などのマルチバイト・キャラクタを使用することはできませ

ん。 たとえば、コンテンツ・タイプを作成する場合、コンテンツ・タイプ名やプロパティ

名には日本語を使用できません。 

Oracle Partitioning の使用についての使用についての使用についての使用について 

Oracle Internet File System 開発者リファレンス リリース 9.0.1（J06084-01）の 3-55 ページお

よび 5-9 ページには、Partitioned 属性、または XML 要素<PARTITIONED>により、コンテン

ツ・タイプのインスタンスを格納する表がパーティション化されるかどうかを指定できると

いう記述があります。このリリースの Oracle 9iFS では、これらの方法を使用したデータベー

ス表のパーティション化はサポート対象外です。 

SimpleXmlRenderer についてについてについてについて 

Oracle 9iFS の標準の XML レンダラ環境である SimpleXmlRendererを使用し、クラス・オ

ブジェクト（Documentなど）をレンダリングすることはできません。使用した場合、実行

時のエラーとして、次のようなメッセージが表示されます。 

oracle.ifs.common.IfsException: IFS-30110: Unable to render LibraryObject 
oracle.ifs.common.IfsException: IFS-10407: Invalid Attribute name(名前) 
この現象は、英語環境以外の Oracle 9iFS でのみ発生します。 

レンダラの実装についてレンダラの実装についてレンダラの実装についてレンダラの実装について 

Oracle Internet File System 開発者リファレンス リリース 9.0.1（J06084-01）の 11-4 ページお

よび 11-5 ページでは、レンダラ・クラスの作成に関して、

oracle.ifs.server.renderers.Rendererインタフェースを実装するという記述があり

ますが、このインタフェースは直接実装できません。かわりに、

oracle.ifs.server.renderers.BaseRendererをサブクラス化して使用してください。  

Oracle 9iFS イベントについてイベントについてイベントについてイベントについて 

Oracle Internet File System 開発者リファレンス リリース 9.0.1（J06084-01）の 13-13 ページで

は、LibraryObject（Documentなど）の作成、更新、削除などに対応した Oracle 9iFS イ

ベントをアプリケーションで簡単に認識できるかのように読み取れる記述があります。 
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しかし、Oracle 9iFS イベントはシステム・レベルのものであるため、アプリケーションで使

用することはできません。  

getServerName()メソッドについてメソッドについてメソッドについてメソッドについて 

oracle.ifs.beans.LibrarySessionクラスの getServerName()メソッドは使用できま

せん。使用した場合、コンパイル時のエラーとして次のメッセージが表示されます。 

method getServerName() not found in class oracle.ifs.server.S_LibrarySession 

getIfsPathFromJSPRedirect()メソッドの制限についてメソッドの制限についてメソッドの制限についてメソッドの制限について 

HttpUtilsクラスの getIfsPathFromJSPRedirect()メソッドで返される iFS パス情報は、

先頭に/ifs/filesが付加された不正な値となります。正しい iFS パスは、

getIfsPathFromJSPRedirect()メソッドで返された値から先頭の 10 文字分

（/ifs/files）を削除した値です。 

例: 

� GetIfsPathFromJSPRedirect()メソッドで返される不正な iFS パス 

/ifs/files/home/scott/sample.jsp 
� 正しい iFS パス（先頭の/ifs/filesを削除） 

/home/scott/sample.jsp 

javax.servlet.http.HttpSession インタフェースのインタフェースのインタフェースのインタフェースの getAttribute()メソッドにメソッドにメソッドにメソッドに 
ついてついてついてついて 

Oracle Internet File System 開発者リファレンス リリース 9.0.1（J06084-01）の 12-6 ページ、

12-9 ページ、12-14 ページ、および 12-16 ページに、javax.servlet.http.HttpSession
インタフェースのメソッド getAttribute()が使用されています。しかし、このリリースで

はかわりに getValue()メソッドを使用する必要があります。 

誤: 

IfsHttpLogin ifsLogin = (IfsHttpLogin) 
request.getSession(true).getAttribute("IfsHttpLogin");  
正: 

IfsHttpLogin ifsLogin = (IfsHttpLogin) 
request.getSession(true).getValue("IfsHttpLogin"); 
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第第第第 2 章章章章  Oracle Internet File System リリース・ノートリリース・ノートリリース・ノートリリース・ノート 
原典情報:  Oracle Internet File System Release Notes, Release 9.0.1 for Linux Intel（A90894-01） 

このリリース・ノートは、Oracle Internet File System（Oracle 9iFS）for Linux Intel リリース 9.0.1
に付随するものです。 

この章では、次の項目について説明します。 

� 新機能 

� 対応クライアント 

� システム・パッチ 

� ハードウェア要件 

� Oracle 9iFS Java API での推奨されていない機能 

� 一般的な問題 

� プロトコル固有の問題 

� 既知の問題 
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新機能新機能新機能新機能 

この項では、管理、コラボレーションおよび開発に関する新機能について説明します。 

管理機能管理機能管理機能管理機能 

Oracle 9iFS における最も大きな変更点は、管理フレームワークが新しくなったことです。

Oracle 9iFS の管理機能は、Oracle Enterprise Manager の新機能を統合および利用することによ

って拡張されています。 

プロトコルおよびエージェントの新しいフレームワークプロトコルおよびエージェントの新しいフレームワークプロトコルおよびエージェントの新しいフレームワークプロトコルおよびエージェントの新しいフレームワーク 

Oracle 9iFS では、これらの新しい管理機能を使用するために、プロトコル・サーバーおよび

エージェントのインフラストラクチャが大幅に変更されました。新しいフレームワークでは、

プロトコル・サーバーやエージェントなど、Oracle 9iFS の複数のインスタンスを単一の Oracle 
Enterprise Manager コンソールから監視できます。Oracle 9iFS をインストールおよび構成する

際に Oracle 9iFS のドメイン内にドメイン・コントローラおよびノードを定義しますが、これ

らは Oracle Enterprise Manager コンソールから管理できます。 

新しいフレームワークの概要は、『Oracle Internet File System for UNIX Systems セットアップ

および管理ガイド』を参照してください。 

Dashboard インタフェースインタフェースインタフェースインタフェース    

Oracle 9iFS 用の Oracle Enterprise Manager コンソール・インタフェースには、すべてのノード

のシステム・ステータスを表示するための複数の Dashboard グラフが追加されています。た

とえば、各プロトコル・サーバーを介して接続しているユーザーの数が Dashboard に表示さ

れます。 

インポートインポートインポートインポート////エクスポート・ユーティリティエクスポート・ユーティリティエクスポート・ユーティリティエクスポート・ユーティリティ    

インポート/エクスポート・ユーティリティを使用すると、Oracle 9iFS ディレクトリ構造の一

部分からすべてのコンテンツおよび関連するメタデータをエクスポートできます。その後、

エクスポートされたファイルを使用して、元の Oracle 9iFS インスタンスまたは新規のインス

タンスにそのコンテンツおよびメタデータを再作成できます。 

拡張性、パフォーマンスおよび信頼性拡張性、パフォーマンスおよび信頼性拡張性、パフォーマンスおよび信頼性拡張性、パフォーマンスおよび信頼性 

拡張性の向上により、ドキュメント・ストアのサイズを拡張すること、および Oracle 9iFS に

接続できる同時ユーザー数と指名ユーザー数を増やすことが以前より簡単にできるように

なりました。Oracle 9iFS に 10,000 人の同時ユーザーが接続できることをテスト済です。Oracle 
9iFSの電子メール配信のパフォーマンスおよびOracle 9iFS IMAPサーバーを使用したコマン

ド実行のパフォーマンスが向上しました。Oracle 9iFS プロトコル・サーバーを実行する場合

と同じように、複数の WCP インスタンスを実行できます。 

また、コンテンツの検索およびフォルダを限定した検索のパフォーマンスが向上しました。 
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メモリー使用量の削減メモリー使用量の削減メモリー使用量の削減メモリー使用量の削減 

同時ユーザー数が多い場合の Oracle 9iFS のメモリー使用量が削減されました。同時ユーザー

の数が少ない場合は、複数のプロトコル・サーバーを単一の Java Virtual Machine（JVM）で

実行することにより、Oracle 9iFS プロトコル・サーバーを実行する際のメモリー・オーバー

ヘッドを低減することができます。 

詳細は、『Oracle Internet File System for UNIX Systems セットアップおよび管理ガイド』を参

照してください。 

コラボレーション機能コラボレーション機能コラボレーション機能コラボレーション機能 

Java Web Server の廃止の廃止の廃止の廃止 

Oracle 9iFS の今回のリリースからは、優先 Web サーバーが Java Web Server（JWS）から Oracle 
HTTP Server powered by Apache に変更されています。JWS はサポートされません。 

NFS プロトコル・サーバープロトコル・サーバープロトコル・サーバープロトコル・サーバー    

NFS プロトコル・サーバーを介して Oracle 9iFS のコンテンツにアクセスできるようになりま

した。 

FileSync ユーティリティユーティリティユーティリティユーティリティ    

Oracle 9iFS では、Microsoft Windows のローカル・ドライブと Oracle 9iFS の間でファイルを

同期化するユーティリティが新たに導入されました。このユーティリティは、定期的に Oracle 
9iFS インスタンス上のファイルに対してアクセスおよび編集を行うユーザーにとって有益

です。 

FileSync ユーティリティのインストールの詳細は、『Oracle Internet File System for UNIX 
Systems インストレーション・ガイド』を参照してください。 

ファイルまたはフォルダの任意メタデータ（カテゴリ）ファイルまたはフォルダの任意メタデータ（カテゴリ）ファイルまたはフォルダの任意メタデータ（カテゴリ）ファイルまたはフォルダの任意メタデータ（カテゴリ） 

Oracle 9iFS では、ファイルまたはフォルダに適用可能な、カテゴリと呼ばれる任意メタデー

タを定義できます。従来、拡張属性はファイル・タイプを基準にしていました。たとえば、

ReadyForPublication プロパティをすべての HTML ファイルに追加することができました。一

方、カテゴリでは、関連する属性を 1 つのセットとして定義し、これらをファイルまたはフ

ォルダに適用できます。たとえば、レビュー・プロセスに必要なすべての情報が記述された

NextReviewer や ReadyForPublication などのカテゴリを定義し、これらを自分の Web サイトで

使用される HTML、GIF、JPG、AVI などのファイルに適用できます。 

エンド・ユーザーとしてこの機能を使用する方法の詳細は、Oracle 9iFS Windows ユーティリ

ティの各ダイアログ・ボックスからアクセス可能なオンライン・ヘルプを参照してください。

管理インタフェースを介してカテゴリをブラウズ、作成および変更する方法の詳細は、

『Oracle Internet File System for UNIX Systems セットアップおよび管理ガイド』を参照してく

ださい。 
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マルチメディア・メタデータの自動抽出マルチメディア・メタデータの自動抽出マルチメディア・メタデータの自動抽出マルチメディア・メタデータの自動抽出 

Oracle 9iFS は Oracle interMedia Annotator を使用して、オーディオ、ビデオおよびイメージ・

ファイルにエンコードされたカラー深度、再生時間、字幕のテキストおよびその他のタイプ

の情報を自動的に抽出し、これらの情報を各ファイルで検索および編集可能な属性に変換し

ます。任意メタデータの使用例として、マルチメディア・ファイルにエンコードされたメタ

データを格納先として使用するケースがあげられます。 

Oracle 9iFS にアップグレードする際、Oracle Internet File System のリリース 1.x を使用して作

成されたオーディオ、ビデオおよびイメージ・ファイルには注釈が付けられません。注釈が

必要な場合は、Oracle interMedia Annotator のエージェントが実行中であることを確認し、こ

れらのファイルを Oracle 9iFS に再ロードしてください。 

この機能を使用するには、管理者は Oracle 9iFS の Oracle Text オプションを使用可能にする

必要があります。Oracle 9iFS インスタンス上で Oracle interMedia を使用可能にする方法の詳

細は、『Oracle Internet File System for UNIX Systems セットアップおよび管理ガイド』を参照

してください。 

Oracle 9iFS Portlet 

Oracle 9iFS には、Oracle Portal に登録可能なポートレットが付属しています。ポートレット

を使用すると、頻繁に使用するフォルダやファイルへのショートカットを提供し、簡単な検

索も行うことができます。 

Oracle 9iFS Windows ユーティリティの改善ユーティリティの改善ユーティリティの改善ユーティリティの改善    

Oracle 9iFS Windows ユーティリティが大幅に改善されています。 

� このソフトウェアは、ユーザーが接続している Oracle 9iFS サーバーに、現在使用して

いるソフトウェアよりも新しいバージョンがあるかどうかを自動的に検出し、ユーザー

のインストール作業をナビゲートします。 

� 複数選択操作を幅広くサポートしているため、ファイルのグループや、フォルダとその

サブフォルダおよびファイルに Access Control List を適用したり、複数のオブジェクト

のチェックイン、チェックアウト、チェックアウト取消し、ロック、ロック解除および

リンク作成を行うことができます。バージョニングしたドキュメントの削除および名前

を変更することもできます。 

� Oracle 9iFS の検索ユーティリティがより便利になり、次のものを検索できます。 

� ドキュメントおよびそのサブクラスのカスタム属性 

� ドキュメントに対応付けられているカテゴリおよびそのサブクラス 

� ドキュメントの言語（ユーザー指定またはサーバーのデフォルト） 

� ドキュメントのすべてのバージョン 



  第 2 章  Oracle Internet File System リリース・ノート 19 

検索ユーティリティは、検索結果の段階的取得およびサーバー側のフォルダ限定検索に

より高速化されました。検索結果の一部のみが返された時点で検索を停止することもで

きます。 

� プロパティ・ダイアログ・ボックスのユーザー・インタフェースが使いやすくなりまし

た。カスタム属性の編集、カテゴリおよびカテゴリ属性のドキュメントおよびフォルダ

への対応付けが可能になりました。また、特定のドキュメントおよびフォルダの全リン

ク先の場所を参照できるようになりました。「セキュリティ」タブが新しくなり、Access 
Control List および Access Control Entry のダイアログ・ボックスにアクセスできるように

なりました。また、Oracle 9iFS Windows ユーティリティと SMB プロトコルの相互動作

におけるパフォーマンスも向上しています。 

開発機能開発機能開発機能開発機能 

マニュアルの充実と改善マニュアルの充実と改善マニュアルの充実と改善マニュアルの充実と改善 

『Oracle Internet File System 開発者リファレンス』は全面的に改訂されました。このマニュア

ルには、Oracle 9iFS 開発のすべての面を網羅した、新しい、詳細な情報が記載されています。 

新規サンプル・コード新規サンプル・コード新規サンプル・コード新規サンプル・コード 

Oracle 9iFS では、幅広いサンプル・コードが提供されています。これらは、『Oracle Internet 
File System 開発者リファレンス』に記載されているほか、製品とともにインストールされま

す。 

すべてのサンプル・コードのリストは、『Oracle Internet File System 開発者リファレンス』に

記載されています。 

Oracle 9iFS データベース・トランザクションでのデータベース・トランザクションでのデータベース・トランザクションでのデータベース・トランザクションでの PL/SQL の実行の実行の実行の実行    

開発者は、リレーショナル・データ・ストアへの変更をコミットするときに Oracle 9iFS が使

用するものと同じデータベース・トランザクションにアクセスできるようになりました。こ

の機能は、ファイル・システム操作の発生と同時にリレーショナル・データベースで作業を

行う場合に重要になります。たとえば、Oracle 9iFS に新しいファイルを挿入する際に Oracle 
Portal で PL/SQL コールを実行する場合、この操作の組合せの Oracle 9iFS トランザクション・

コンテキストを使用できます。 

任意メタデータの新規オプション任意メタデータの新規オプション任意メタデータの新規オプション任意メタデータの新規オプション 

任意メタデータ・インタフェース（カテゴリ）用の新しいデータ型が Oracle 9iFS Software 
Development Kit（SDK）に追加されました。これを使用して、プログラミングによってカテ

ゴリを作成、編集、適用および検索できます。 
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新規電子メール・オブジェクトと新規電子メール・オブジェクトと新規電子メール・オブジェクトと新規電子メール・オブジェクトと API    

電子メール用の Oracle 9iFS SDK コンポーネントが変更されました。以前は、電子メールは

複数の異なるオブジェクトで構成されており、電子メールを処理するにはこれらのオブジェ

クトに対してアクセスおよび操作を行う必要がありました。現在、電子メールは単一のオブ

ジェクトになりました。また、Oracle 9iFS 固有のインタフェースのかわりに Java メール API
を使用して、電子メールを生成および処理できます。 

XML 名前空間名前空間名前空間名前空間    

Oracle 9iFS とともにインストールされる XML Parser は、ドキュメント内で定義した Oracle 
9iFS の名前空間を認識します。これにより、Oracle 9iFS の構成に使用する XML ファイルと

Oracle 9iFS に格納する XML ファイルとの間でドキュメント定義と属性名の競合が発生する

ことを回避できるようになりました。たとえば、Oracle 9iFS 固有のファイルが新しい名前空

間の機能を使用する場合は、多くの XML ファイルで使用される<CONTENT>タグが Oracle 
9iFS のコンテンツ・オブジェクトと競合することはありません。 

ラウンドトリップラウンドトリップラウンドトリップラウンドトリップ XML    

ラウンドトリップ XML を使用して、XML ファイル内のコメントおよび認識されない要素の

すべてを保持できるようになりました。以前は廃棄されていた未解析のコンテンツを、現在

は保持するように Oracle 9iFS を構成できるため、元の XML ファイルの完全な再作成が可能

です。また、この機能を使用するとレンダリングされた XML ファイルに存在するが元のフ

ァイルには存在しない要素（レンダリングされた XML コンテンツに追加された Oracle 9iFS
属性など）を削除することもできます。 

カスタムカスタムカスタムカスタム XML レンダリングレンダリングレンダリングレンダリング    

レンダリングする要素のサブセットを選択できるようになりました。デフォルトでは、その

Oracle 9iFSクラスに固有の拡張要素のみがデータベースからブラウザにレンダリングされま

す。そのスーパークラスから他の要素を追加することも、レンダリングの目的でこれらの拡

張要素を省略することもできます。 

対応クライアント対応クライアント対応クライアント対応クライアント 

次に示す各バージョンのクライアント・ソフトウェアは、Oracle 9iFS で使用できることを確

認済です。 

� Microsoft Windows 用 Web ブラウザ（FTP、IMAP4、SMTP、HTTP および Web インタフ

ェース用） 

� Netscape Communicator 4.7x 

� Microsoft Internet Explorer 5.0 以上および Outlook Express 
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� Windows クライアント・オペレーティング・システム（SMB でのアクセス、Windows
ユーティリティおよび Web インタフェース用） 

� Microsoft Windows NT 4.0 Workstation および Server（Service Pack 6 以上） 

� Microsoft Windows 95、98 および ME 

� Microsoft Windows 2000 Professional および Server 

� Macintosh 用 Web ブラウザ（Web インタフェース用） 

� Netscape Communicator 4.7x  

� Macintosh クライアント・オペレーティング・システム（Thursby Software 社の DAVE 2.5.1
を使用した SMB アクセスおよび Web インタフェース用） 

� Mac OS 9.0.4 および 9.1 

� NFS アクセス 

� SuSE 7.1 NFS クライアント 

� Hummingbird NFS Maestro 6.0 for Windows 95/98/NT 

� Hummingbird NFS Maestro 7.0 for Windows NT/2000 

� OnNet 7.0 

� FTP アクセス 

� OnNet FTP 4.0 

� Eudora 4.3（IMAP および SMTP 用） 

� PINE 4.2（IMAP および SMTP 用） 

システム・パッチシステム・パッチシステム・パッチシステム・パッチ 

Oracle 9iFS のインストールを行う前に、パッチ 1859905 をインストールする必要があります。

このパッチは、CD-ROM の patch ディレクトリにあります。 

インストールを正しく実行するには、2 つ目のパッチ glibc-2.2.2-53.i386.rpmが必要

です。このパッチは、SuSE の次の URL から入手できます。 

http://www.suse.de/~aj/glibc-7.2-jdk 
このパッチは、Oracle HTTP Server powered by Apache を SDK 1.3.1 を使用して構成する場合

に必要です。 

http://www.suse.de/~aj/glibc-7.2-jdk
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ハードウェア要件ハードウェア要件ハードウェア要件ハードウェア要件 

この項では、Oracle 9iFS のハードウェアの最小構成および推奨構成について説明します。 

最小構成最小構成最小構成最小構成 

次に示す構成の数値は、2 層構造で、すべてのプロトコル・サーバーを実行する場合の数値

です。この構成では約 2 人のユーザーが約 2 つのプロトコルで同時にアクセスするという環

境をサポートします。 

� Pentium II 233 MHz 

� 512MB の RAM および 1GB のスワップ領域 

� 5GB のディスク領域（データベース用に 4.5GB、Oracle 9iFS 用に 500MB） 

注意注意注意注意::::    Oracle Enterprise Manager コンソールおよびすべての Oracle 9iFS プロトコル・サーバ

ーを同時に実行しない場合は、RAM が 512MB 未満であっても、Oracle9i データベー

スと同じマシン上で Oracle 9iFS を実行できる場合があります。 

推奨構成推奨構成推奨構成推奨構成 

データベースと Oracle 9iFS を同じマシンで実行する場合、この構成では、約 50 人のユーザ

ーが各プロトコルで適度にアクセスするという環境をサポートします。この構成には、追加

のリソースが必要となる Oracle Enterprise Manager コンソールの実行は含まれません。 

� Pentium III Xeon 550 MHz 以上 

� 1GB の RAM および 2GB のスワップ領域 

� 5GB のディスク領域（データベース用に 4.5GB、Oracle 9iFS 用に 500MB） 

Oracle 9iFS サーバーに接続するユーザーが 50 人を超える場合は、Oracle9i データベースと

Oracle 9iFS は別々のマシンにインストールする必要があります。 
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Oracle 9iFS Java API での推奨されていない機能での推奨されていない機能での推奨されていない機能での推奨されていない機能 

Oracle 9iFS Java API では新しい機能およびテクノロジを採用しているため、特定のクラス、

フィールドおよびメソッドが廃止されている可能性があります。これらの推奨されていない

機能は、次回のメジャー・リリースで削除される予定です。これにより、ユーザーは、サポ

ートされているクラス、フィールドおよびメソッドを使用したアプリケーションに変更する

ための十分なリリース・サイクルを確保できます。 

このリリースで推奨されていない機能を確認するには、Javadoc の「Deprecated」リンクを参

照してください。それぞれの推奨されていない機能には、サポートされている同等の使用方

法を示すコメントが付けられています。-deprecationフラグを付けて Java アプリケーシ

ョンをコンパイルすることにより、自分のアプリケーションで問題のあるクラス、フィール

ドまたはメソッドを使用していないかどうかをチェックすることもできます。 

コレクションの改善コレクションの改善コレクションの改善コレクションの改善 

このリリースでは、Oracle 9iFS の java.util.Collectionsの実装が変更され、拡張性が

向上しました。主な変更点は次のとおりです。 

� コレクション内のすべての項目がキャッシュされるわけではなくなりました。 

� Collection はクラスからインタフェースに変更されました。 

� 新しい Collection インタフェースのメソッドは、以前の Collection クラスのメソッドと

同じシグネチャを持つようになりました。 

新しい実装クラス新しい実装クラス新しい実装クラス新しい実装クラス 

次の図は、Collection インタフェースと実装クラスの関係を示しています。 

oracle.ifs.common.Collection (interface) 
| 
+---oracle.ifs.common.CachedCollection (abstract) 
| | 
| +--- oracle.ifs.common.CachedSelectorCollection 
| | 
| +--- oracle.ifs.common.CachedResolverCollection 
| 
+---oracle.ifs.common.UncachedResolverCollection 
LibrarySession および S_LibrarySession の get*Collection()メソッドの宣言された戻り値

は、適切な Collection サブクラスを反映するように変更されています。 
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エラー・コードエラー・コードエラー・コードエラー・コード 

Collection のメソッドのエラー・コードが変更されています。指定した名前が無効な場合、

Collection.getItems(String)によって発生する例外スタックは次のようになります。 

iFS 1.1: 
IFS-12200 ("無効な項目名が指定されました。") 
IFS-12214 ("名前でコレクションの項目を取得できません。") 
IFS-12200 ("無効な項目名が指定されました。") 
エラー・コードに対するこの変更の例として、次のようなエラー・コードがあるとします。 

if (e.getErrorCode() == 12200) 
今回のリリースでは、エラー・コードを次のように変更します。 

if (e.containsErrorCode(12200)) 
一般的に、特定のエラーが予測される場合は、containsErrorCode()を使用することをお

薦めします。この方法により、例外スタックのエラー・コードが変更されても、ユーザーの

コードが保護されます。 

これらのクラスの詳細は、Javadoc を参照してください。 

一般的な問題一般的な問題一般的な問題一般的な問題 

Oracle Text による索引付けによる索引付けによる索引付けによる索引付け 

管理者は、どのドキュメントで Oracle Text による索引付けの際にエラーが発生したのかを確

認することができます。サンプル・スクリプトは次のとおりです。 

$ORACLE_HOME/9ifs/admin/sql/ViewContextErrors.sql 
Oracle Text による索引付けの際に各ドキュメントを監視するには、Oracle Text 索引を同期化

する前にプロシージャ ctx_output.add_event()を使用します。サンプル・スクリプト

は次のとおりです。 

$ORACLE_HOME/9ifs/admin/sql/SyncContextIndex.sql 
Oracle Text によって索引付けされたドキュメントについてより詳細な情報も表示できます。

サンプル・スクリプトは次のとおりです。 

$ORACLE_HOME/9ifs/admin/sql/ViewDocumentByRowID.sql 
Oracle Text を使用して Oracle 9iFS ドキュメントを索引付けする方法の詳細は、『Oracle 
Internet File System for UNIX Systems セットアップおよび管理ガイド』を参照してください。 
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検索タイムアウト・パラメータ検索タイムアウト・パラメータ検索タイムアウト・パラメータ検索タイムアウト・パラメータ 

結果が返されていない実行中の検索のデフォルトのタイムアウト時間を表すための、サービ

ス構成パラメータが用意されています。デフォルトのサービス構成の場合、

IFS.SERVICE.SESSION.DefaultSearchTimeoutPeriodパラメータの値は 60（秒）に

設定されています。 

デフォルトのタイムアウト時間を変更する場合は、

IFS.SERVICE.SESSION.DefaultSearchTimeoutPeriodパラメータを変更します。 

タイムアウト・パラメータの詳細は、『Oracle Internet File System for UNIX Systems セットア

ップおよび管理ガイド』を参照してください。 

管理者による管理者による管理者による管理者による Oracle データベース上でのデータベース上でのデータベース上でのデータベース上での analyze スクリプトの実行スクリプトの実行スクリプトの実行スクリプトの実行 

Oracle 9iFS では Oracle データベースの拡張機能を使用しているため、Oracle 9iFS で Oracle
のコストベース・オプティマイザ（CBO）を使用して、SQL 文を実行する際の最も効率的な

方法を決定する必要があります。CBO を正しく動作させるには、管理者は、Oracle 9iFS を使

用する前に analyze スクリプトを実行する必要があります。このスクリプトは、Oracle 9iFS
の使用中に定期的に（特に、ユーザーが大量のファイルを Oracle 9iFS にロードした後、また

はユーザーがその他の方法でデータを変更した後）実行する必要があります。 

Linux Intel で、次のコマンドを入力します。 

cd $ORACLE_HOME/9ifs/admin/sql 
sqlplus ifssys/<password> @analyze.sql ifssys 
このコマンドの ifssysは Oracle 9iFS のスキーマ名です。 

Oracle 9iFS に多数のドキュメントが存在する場合は特に、このスクリプトが完了するまでに

数分かかる可能性があります。通常、このスクリプトはシステムの負荷が少ない時間帯に実

行します。 

コストベース・オプティマイザの詳細は、『Oracle9i データベース・パフォーマンス・ガイ

ドおよびリファレンス』を参照してください。 

Oracle 9iFS のユーザー名におけるマルチバイト・キャラクタ使用の制限のユーザー名におけるマルチバイト・キャラクタ使用の制限のユーザー名におけるマルチバイト・キャラクタ使用の制限のユーザー名におけるマルチバイト・キャラクタ使用の制限 

Oracle 9iFS では、マルチバイトのユーザー名の使用はサポートされていません。 
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プロトコル固有の問題プロトコル固有の問題プロトコル固有の問題プロトコル固有の問題 

Web アクセスアクセスアクセスアクセス 

HTTP を介して Oracle 9iFS にアクセスするには、次の形式による URL を使用します。 

http://<server-name>:<port number>/ifs/files 
デフォルトのポート番号は 7777 です。この場合、URL は次のようになります。 

http://myserver.mycompany.com:7777/ifs/files 
この例の myserver.mycompany.comがサーバー名で、7777 がポート番号です。 

この URL は、次のようなアクセスの場合に必要です。 

� Web ブラウザを介した Web インタフェースへのアクセス、または HTTP を介してファ

イルを直接取得するためのアクセス 

� Web フォルダなどの WebDAV アプリケーションを介したアクセス 

� FileSync 機能を使用した Oracle 9iFS へのアクセス 

NFS プロトコルのサポートプロトコルのサポートプロトコルのサポートプロトコルのサポート 

Oracle 9iFS には NFS サーバーが含まれています。NFS がデフォルト以外のポートで動作す

るように構成されている場合は、mountコマンドを使用する必要があります。次に、Linux 
Intel システムでのコマンドの例を示します。 

mount -o port=4098,mountport=4097 ifs.mydomain.com:home /mnt/mntpoint 
この例では、portと mountportの値は、Oracle 9iFS Configuration Assistant で構成された値

によって定義されています。ifs.mydomain.comは NFS プロトコルのホスト、homeはエ

クスポートされているディレクトリ、/mnt/mntpointはローカル・マシン上のマウント・

ポイントです。 

Oracle 9iFS NFS サーバーの構成、NFS クライアントの構成、および Oracle 9iFS アカウント

への Linux ユーザーのマッピングの詳細は、『Oracle Internet File System for UNIX Systems イ
ンストレーション・ガイド』を参照してください。 

Oracle 9iFS NFS サーバーの制限事項サーバーの制限事項サーバーの制限事項サーバーの制限事項    

Oracle 9iFS NFS サーバーには、次のような制限事項があります。 

� アクセス権モード・ビットは無効です。 

Oracle 9iFS NFS サーバーは、ドキュメントの所有者、カレント・ユーザーおよびパブリ

ック・アクセスに対し、読取り、書込みおよび実行権限を制御するアクセス権モード・

ビットを返します。しかし、ドキュメントに対する実際のアクセスは、Oracle 9iFS Access 
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Control List（ACL）によって制御されます。Oracle 9iFS NFS サーバーによって返される

モード・ビットは、ユーザーが使用できる実際のアクセスを反映しない場合があります。 

� UNIX コマンドを使用して所有者、グループまたはモードを変更できません。 

UNIX の chown、chgrpまたは chmodコマンドを使用して、Oracle 9iFS NFS サーバー

内のドキュメントの所有者、グループおよびモードを変更することはできません。これ

らのコマンドは成功したように見えますが、実際にはドキュメントの属性は変更されて

いません。 

� Oracle 9iFS NFS サーバーでは、バージョニングされたドキュメントのチェックアウト済

バージョンへのアクセスは許可されません。 

これは、NFS クライアントが使用するキャッシング・アルゴリズムに違反するためです。

このアルゴリズムは、すべてのユーザーに対してファイルの内容が同じであることを前

提としています。ドキュメントをチェックアウトしたユーザーは他のユーザーとは異な

る内容のドキュメントを参照する可能性があるため、チェックアウト済バージョンのド

キュメントへのアクセスを許可すると、この前提に違反することになります。 

� バージョニングされたドキュメントは、削除、移動または名前の変更はできません。 

Microsoft Office アプリケーションなどのアプリケーション・ファイルを保存する場合、

最初にデータをテンポラリ・ファイルに保存し、続いて元のファイルを削除してから、

テンポラリ・ファイルを元のファイル名に変更します。バージョニングされたドキュメ

ントの場合、このように処理すると旧バージョンがすべて失われます。したがって、バ

ージョニングされたドキュメントの削除、移動または名前の変更は許可されません。 

� Oracle 9iFS NFS サーバーから返されたハンドルは、UNIX のロック・マネージャ（NLM）

との互換性はありません。 

Oracle 9iFS NFS サーバーと NLM 間の互換性がないため、UNIX のロック・マネージャ

を必要とするプログラムは、Oracle 9iFS NFS サーバーでは使用できません。 

� UNIX 形式のリンクには、Oracle 9iFS との互換性はありません。かわりに、Oracle 9iFS
リンクを使用できます。 
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Oracle 9iFS FileSync ユーティリティの制限事項ユーティリティの制限事項ユーティリティの制限事項ユーティリティの制限事項    

FileSync ユーティリティは、ユーザーがローカル・マシン上で行った変更、およびユーザー

または他のユーザーが Oracle 9iFS 上で行った変更を検出でき、ほとんどの場合、これらの変

更によって生じる競合を解決できます。ただし、特定の変更のタイプによって発生した競合

については、現在は FileSync では解決できない場合があります。競合を解決できない場合、

FileSync ではこのようなファイル変更の同期化をスキップするためのオプションのみが使用

可能になります。 

現在、次のタイプの競合は解決できません。次の説明にあるソースは元のファイル、ターゲ

ットは生成されるファイルのことを指します。 

� 新規/削除: 「新規」のターゲットが「削除」のソースと競合する場合。たとえば、ロ

ーカル・フォルダと Oracle 9iFS フォルダを同期化しているときに新規のファイルをロ

ーカル・フォルダに作成したが、Oracle 9iFS のフォルダが削除されている場合です。現

在、この競合は解決できません。 

� 新規/コピー: 「新規」のターゲットが「コピー」のソースまたはターゲットと競合す

る場合。 

� 新規/編集: 「新規」のターゲットが「編集」のターゲットと競合する場合。 

� 新規/移動: 「新規」のターゲットが「移動」のソースまたはターゲットと競合する場

合。 

� 移動/編集: 「編集」のターゲットが「移動」のソースまたはターゲットと競合する場

合。 

� 移動/削除: 「削除」のソースが「移動」のソースまたはターゲットと競合する場合。 

� 移動/移動: 「移動」のソースと「移動」のターゲット双方で競合が発生する可能性が

ある場合。 

� コピー/コピー: 「コピー」のソースと「コピー」のターゲット双方で競合が発生する

可能性がある場合。 

� コピー/削除: 「削除」のソースが「コピー」のソースまたはターゲットと競合する場

合。 

� コピー/編集: 「編集」のターゲットが「コピー」のソースまたはターゲットと競合す

る場合。 

� コピー/移動: 「コピー」のソースと「移動」のターゲットおよび「移動」のソースと

「コピー」のターゲット双方で競合が発生する可能性がある場合。 
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マルチバイト・ロケールにおけるマルチバイト・ロケールにおけるマルチバイト・ロケールにおけるマルチバイト・ロケールにおける Web インタフェースでのドラッグインタフェースでのドラッグインタフェースでのドラッグインタフェースでのドラッグ&ドロドロドロドロ

ップ機能によるアップロードップ機能によるアップロードップ機能によるアップロードップ機能によるアップロード 

マルチバイト対応の Internet Explorer の不具合のため、ドラッグ&ドロップ機能によるアップ

ロードは、Oracle 9iFS サーバーのデフォルト・キャラクタ・セットとクライアント・マシン

のキャラクタ・セットが一致する場合にのみ実行可能です。 

FTP でのドラッグでのドラッグでのドラッグでのドラッグ&ドロップ機能におけるドロップ機能におけるドロップ機能におけるドロップ機能における Web プロキシプロキシプロキシプロキシ 

Web ブラウザが FTP でプロキシを使用しないように、Web ブラウザの設定を変更する必要

がある場合があります。Web プロキシを使用すると、Web インタフェースでドラッグ&ドロ

ップ機能を使用してサーバーにファイルをアップロードする際に問題が発生する可能性が

あります。 
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既知の問題既知の問題既知の問題既知の問題 

この項では、Oracle 9iFS リリース 9.0.1 での既知の問題を示します。適切な回避策がある場

合は記述されています。問題は、プロセスごと、またはコンポーネントごとにまとめられて

います。 

� Installation Bugs 

� Generic Oracle 9iFS Bugs 

� XML Bugs 

� Windows and SMB Bugs 

� Windows Utilities Bugs 

� Web Interface Bugs 

� FTP Bugs 

� E-mail Bugs 

� HTTP Bugs 

� Oracle 9iFS Manager Bugs 

Installation Bugs 
The following table describes the known installation bugs and provides workarounds when 
appropriate.  

 

Bug Number Description and Workaround 

Bug 1865469 When you de-install Oracle 9iFS software and then reinstall it in the same 
Oracle home directory using the same Oracle 9iFS schema, the Intelligent 
Agent will be unable to discover the Oracle 9iFS domain controller and node 
that existed in the schema previously. 

Workaround: Before de-installing, make a backup copy of 
$ORACLE_HOME/network/agent/config/ifs.ora. After 
re-installing the Oracle 9iFS software, run the Oracle 9iFS Configuration 
Assistant, and choose to re-use the same schema. Next, restore the backup copy 
of ifs.ora so that the Intelligent Agent will be able to discover the Oracle 
9iFS domain controller and nodes.  
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Bug 1852624 If the Oracle 9iFS Configuration Assistant schema upgrade fails, a subsequent 
upgrade of the same schema may not enable Oracle Text.  

Workaround: Manually enable Oracle Text using the scripts to create the 
Context index provided in $ORACLE_HOME/9ifs/admin/sql. 

Bug 1860278 Oracle 9iFS Configuration Assistant may stop responding on "Verifying Oracle 
JServer" under unusual circumstances. 

Workaround: If the step does not complete within two minutes, kill the process 
and re-start the Oracle 9iFS Configuration Assistant. 

Bug 1866051 The step of "Checking available ports" when running the Oracle 9iFS 
Configuration Assistant may take several minutes if the Apache Web Server or 
the Oracle 9iFS JServ process is running.  

Workaround: Stop the Oracle 9iFS JServ process using the following 
command: 

ifsJservctl -stop  
Stop the Apache Web Server using the following command:  

apachectl stop 
Wait for the ports to clear, then rerun the Oracle 9iFS Configuration Assistant.  

Bug 1529995 When performing an upgrade from Oracle Internet File System release 1.x to 
Oracle 9iFS, the value domain used by Oracle 9iFS Manager to manage 
renderer policies is removed and recreated to accommodate new renderer 
policies added for WebDAV and e-mail. Any custom renderer policies created 
and added to this value domain will be lost. Note that the policy is not removed 
since Oracle 9iFS Manager cannot see the policies. This does not affect any of 
the standard renderer policies.  

Workaround: Note the custom renderer policies added into the value domain. 
After you install Oracle 9iFS, add these entries back into the value domain, for 
example, through the Oracle 9iFS Manager. 
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Generic Oracle 9iFS Bugs 
The following table describes the known Oracle 9iFS bugs and provides workarounds when 
appropriate.  

 

Bug Number Description and Workaround 

Bug 1857689 Conflicting custom classes must be deleted and re-created with new names that 
do not conflict prior to upgrading. The new classes added to Oracle 9iFS are:  

� interMediaAudio 

� interrMediaAudioCdTrack 

� interMediaImage 

� interMediaMovie 

� interMediaSource 

� interMediaVideo 

� MediaTextBlob 

� NodeConfiguration 

� PortletUserProfile 

� Rfc822ContentObject 

� Rfc822Message 

� ServerConfiguration 

� ServiceConfiguration 

Bugs 1837169, 
1840606 

Content indexing of PDF documents through Oracle Text is slower in the Oracle 
8.1.7.2 and Oracle9i database, release 1 than it was in Oracle 8.1.7.0.0 database.  

Workaround: Ensure that sufficient CPU capacity is available on the machine 
running the Oracle database. Two CPUs or more is recommended.  
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Bug 1736391 The Oracle interMedia Annotator will attempt to parse International Press 
Telecommunications Council (IPTC) metadata in JPEG files when none is 
actually present. This results in an exception in the log files. Since Oracle 9iFS 
does not take advantage of IPTC information even when it's present, you may 
want to disable IPTC parsing.  

Workaround: Stop the interMedia Annotator agent.  

Edit $ORACLE_HOME/ord/Annotator/lib/ descriptors/ 
parsers/JpgParser.xml and change the line: 

<ParameterValue> true </ParameterValue> 
to  

<ParameterValue> false </ParameterValue> 
Restart the interMedia Annotator agent. Any JPG files that previously failed to 
be annotated due to this issue will be reparsed.  

Bug 1724775 Content-based searches using the Boolean OR operator with criteria that should 
also return non-indexed files will only return indexed files. For example, a 
content-based search, such as "all files containing 'Oracle' using the OR operator 
with an attribute search fails to return the non-indexed files in the search result.  

Workaround: Break the search into two searches: a content search and a 
attribute search.  

Bug 1833065 Each time the interMedia Annotator fails to annotate a file, node log file may 
have stack traces with exceptions IFS-45371 and IFS-46402. These two 
exceptions are logged, and the stack trace is dumped to the log.  

Workaround: None.  

Bug 1855983 In a multi-byte Oracle Text-enabled installation, multi-media files (audio, video 
and images) are automatically annotated by the interMedia Annotator agent. For 
some installations, the interMedia Annotator puts invalid characters in as the 
category metadata.  

Workaround: Change the environment variable LANG to match the native 
language (for example, Korean should be set to LANG=ko), and restart Oracle 
9iFS.  
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XML Bugs 
The following table describes the known XML bug and provides a workaround for it. 

 

Bug Number Description and Workaround 

Bug 1600470 By default, creating a user through XML will create the e-mail address by 
concatenating the Username and the EmailAddressSuffix. If the username 
contains multi-byte characters, then the user creation fails because an e-mail 
address cannot contain multi-byte characters. 

Workaround: Explicitly set the e-mail address without multi-byte characters 
using the EmailAddress tag. 

 

Windows and SMB Bugs 
The following table describes the known Windows and SMB bugs and provides workarounds when 
appropriate. 

 

Bug Number Description and Workaround 

Bug 1791830 On Windows NT and 2000 systems, double-clicking on a Microsoft Office file, 
such as *.doc, and *.xls,  with a high ASCII character in the filename 
(characters which are not 7-bit USASCII)  causes the error "The file could not 
be found".  

Workaround: Launch the Microsoft Office application and then use File > Open 
to open the file.  

Bug 809516 When using the MS-DOS command shell on Windows 95 and Windows 98 
systems, file names are not displayed for files on the Oracle 9iFS server. 

Workaround: Use the Windows Explorer and Desktop for all file operations on 
Windows 95 and Windows 98 systems. 

Bug 1113581 Attempts to delete or rename a versioned file in SMB result in a failure message 
indicating that all or part of the file may be locked. Certain applications, such as 
Microsoft Word and Microsoft Excel, save the files by deleting old versions of 
the document. This would cause a loss of data attributes and compromise the 
versioning features of Oracle 9iFS. The Oracle 9iFS SMB server does not allow 
deletion or renaming of versioned files 

Workaround: Through Windows Explorer, right click on the versioned document 
and use the “Delete Versioned Document” capability of Oracle 9iFS Windows 
Utilities or use the Web interface. 
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Bug 1115154 Attempts to save a versioned document result in an error message indicating that 
all or part of the file may be locked. 

This error appears for one of two reasons: 

� Files associated with certain applications, such as Microsoft Word and 
Microsoft Excel, cannot be edited in place in Oracle 9iFS. These 
applications delete previous versions of the document as part of the 
save process. 

Solution: When working with files that produce such errors, try saving the 
file to a local directory and then copying it on top of the Oracle 9iFS 
versioned file. 

� A versioned file cannot be edited before first being checked out by the 
user. 

Solution: To edit a versioned file, check it out. 

Bug 1243158 Locking a folder in Oracle 9iFS will prevent all users from renaming and 
deleting a folder. Locking a folder will also prevent items from being added or 
removed from that folder. Because this extra functionality is not designed into 
Windows and current Windows applications, locking an Oracle 9iFS folder 
through setting the Windows read-only attribute is not permitted. 

Workaround: To prevent users from changing the contents of a folder, lock it 
through another interface, such as the Web interface. This will prevent Windows 
users from adding or removing files from the folder; however, this technique 
will not prevent the users from modifying the files in the folder unless those 
files are also locked. 

Bug 1254675 After saving a file through SMB there may be a delay of up to a minute before 
those changes are visible to other users and other protocols. This is caused by 
local caching by the Windows operating system which benefits Windows 
performance. 

Workaround: The changes are shown immediately if the user refreshes the 
directory listing from the Windows Explorer. 

Bug 1364155 Saving a Microsoft Word 95 file on some Windows 95 client machines results 
in an error that the file is in use. 

Workaround:  

1. Use the Save As command to save the file with a different name. 

2. Open the locked file and replace the old contents with the new contents 
using cut and paste. 

3. Save the original file with the new contents. 
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Bug 1374563 Attempting to open a versioned Microsoft Excel file (*.xls) that is not checked 
out causes a Microsoft Excel error message indicating that the document is 
being modified by another user when using SMB. The file can be opened in 
read-only mode. 

Workaround: The document is not being modified by another user, but since the 
document is not checked out it is locked and cannot be written to. Confirm 
opening the file in read-only mode or check it out. 

Bug 1401439 After extracting a large number of files using WinZip, the user may be unable to 
read or write any more files from the mapped drive. The user may get an error 
similar to "Too many files are currently in use. Quit one or more programs, and 
then try again." or an error that a file could not be opened. 

Workaround: The user can unmap and re-map the network drive. The 
administrator can also increase the default maximum number of open files per 
mountpoint for the SMB server using the following parameters: 

MaxOpenFiles = 30 
MaxAllOpenFiles = 100 

Increase them as necessary until the problem is resolved. 

Bug 1622123 All system administrators have the Private ACL as their default ACL. This 
means when an administrator populates Oracle 9iFS using the drag-and-drop 
function in SMB, all folders and files will have the Private ACL. No other users, 
except system administrators, will be able to access the folders or files. 

Workaround: Load the files as a non-system administrator. These users have 
Published as their default ACL. 

 

Windows Utilities Bugs 
The following table describes the known Windows Utilities bugs and provides workarounds when 
appropriate. 

 

Bug Number Description and Workaround 

Bug 1873831 When using the Find function on Oracle 9iFS to find large numbers of 
documents over many queries, the client machine may run out of memory. 

Workaround: Close the Find function on Oracle 9iFS application and start it 
again. 
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Bug 1845460 Control characters in file attributes may give an IFS-1003 exception. If you see 
the exception IFS-1003 when the Windows Utilities is attempting to display the 
results of a Find, it may be because there is a control character in the file 
attributes. 

Workaround: Isolate the problem file and remove control characters from the 
attributes of that file. 

Bug 1807421 In the Oracle 9iFS User Profile dialog, the keyboard shortcuts stops working for 
the fields "Old Password" (ALT+O) and "New Password" (ALT+N) if there is 
has been any password authentication errors. 

Workaround: Use the tab key or the mouse to navigate to these fields. 

Bug 1728051 Oracle 9iFS Find function using Category may return duplicate results if a 
document is associated with more than one category. Those categories have a 
subclass/superclass relationship, and the search on the superclass will result in  
duplicated documents in the result set. 

Workaround: Ignore the duplicate documents. 

Bug 1416975 In Windows NT, if you use the drag-and-drop function with a file that has a file 
name longer than 256 characters, then some of the Windows Utilities will not 
work.  

Workaround: None. This is a Microsoft Windows limitation.  

 

Web Interface Bugs 
The following table describes the known Web interface bugs and provides workarounds when 
appropriate. 

Bug Number Description and Workaround 

Bug 1831286 Uploading very large documents (for example, over 100 MB) using Browse 
in the Web interface can fail.  

Workaround: Use the drag-and-drop function to upload, use FTP directly, or 
another protocol. 

Bug 1859980 When you resize the browser window on a Macintosh, you may notice that 
the tree (left) and container (right) frames do not reload.  

Workaround: After resizing the window, press the reload button. The tree 
(left frame) will not retain its current state. 
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Bug 1860905 If you create a folder with high ASCII characters (8-bit characters), you 
cannot create a link to that folder in the Oracle 9iFS portlet.  

Workaround: Choose a folder name that does not contain high ASCII 
characters.  

Bug 1831063 Occasionally stale data in the browser cache will prevent you from logging 
into the Oracle 9iFS Web interface even if username and password are 
correct. 

Workaround: Clear the browser's cache by pressing the Shift key and 
clicking Reload.  

Bug 1842888 In Netscape, squares sometimes appear instead of multi-byte characters. 
When the font names specified in the Oracle 9iFS Web interface are not 
recognized by the browser.  

Workaround: Change settings in Netscape to "Use my default fonts and 
override document specified fonts". 

Bug 1853303 Clicking does not always open the folder in the container (right) frame. After 
opening a folder using the tree (left) frame, subsequent clicking on folders in 
the container (right) frame may fail to display their contents.  

Workaround: Use the tree (left) frame to open folders and other container 
objects.  

Bug 1104090 In Netscape, uploading a folder using the drag-and-drop function fails. This 
is a Netscape browser issue. 

Workaround: You have three options: 

� If the folder's contents are not folders, first create the folder in 
Oracle 9iFS, then upload the folder's contents using the 
drag-and-drop function. 

� Upload using Browse rather than the drag-and-drop function. 

� Use Internet Explorer. 

Bug 1235607 If quotas are being used, and you are currently near or over your quota, then 
you may not be able to upload any files, even if you are attempting to 
replace an existing file. 

Workaround: Delete the file you are replacing before attempting the upload. 

Bug 1244053 After entering a username and password, pressing the Enter key causes login 
screen to beep on the login.jsp. 

Workaround: Press the Tab key to select the Login button before pressing 
Enter. 
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Bug 1248003 After resizing the window, the headings on the File List no longer appear. 
The text is black on a black background.  

Workaround: This is a style sheet and browser issue. Reload the File List by 
clicking the current folder in the Directory Tree. 

Bugs 1252587, 
1106093, 1263638 

When executing tasks that require a long time to complete, such as complex 
searches, searches over a very large data set, or deleting a large folder tree, 
the connection times out and fails. 

Workaround: Shut down the service and increase the 
SessionTimeoutPeriod parameter in the properties file and restart the 
service. The default value is 10 minutes. 

Bug 1258791 A design issue in the Web interface limits the number of items you can have 
selected when you choose Apply ACL from the Edit menu. Cannot apply 
ACLs to more than 100 items in the Web interface at one time. 

Workaround: Select fewer than 100 items when you are applying ACLs. 

Bug 1370141 If you set the Windows NT display parameters to use small fonts, the menu 
options in the Upload and Check-In/Check-Out menus overlap one another. 
This problem only occurs in Netscape browsers. 

Workaround: Change the font settings in the Display section of the Windows 
control panel to use medium or large fonts. 

Bug 1372615 Using Internet Explorer 5.0 or 5.5 to upload a file with a non-ASCII file 
name with the drag-and-drop function results in an error message that the 
file already exists. Choosing to overwrite the non-existent file causes the 
filename to be truncated when the file is stored in Oracle 9iFS. 

Workaround: This is a known NLS bug with the FTP window in Internet 
Explorer 5.0 or 5.5. Upload using Browse, or use a different protocol server 
to upload the file. 

Bug 1374498 Non-ASCII file name is displayed as squares while viewing its parents. For a 
file with a non-ASCII name, if you open the View Parents window to see all 
the folders in which a file appears, the file name appears as a series of 
rectangles. 

Workaround: Set your browser to ignore typefaces. For example, in 
Netscape, select Edit > Preferences > Appearance and set Fonts option to 
"Use My Default Fonts." 

Bug 1384904, 
1379837, 1374374 

Cannot upload a file with non-ASCII characters in filename when using the 
Browse function and Netscape.  

Workaround: Use Internet Explorer or a different protocol to upload the file, 
such as FTP or SMB. 
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Bug 1387938 The drag-and-drop function from the Web interface to upload may fail if the 
path to the server is not fully qualified when using FTP. 

Workaround: Either fully qualify the path to the server (for example, 
http://myserver.mycompany.com:2100) or use a different 
protocol server to upload the file. 

Bug 1399626 Uploading a file using the drag-and-drop function into a folder with a period 
in its name causes the file to open in Internet Explorer instead of being 
uploaded. 

Workaround: Navigate one level up from the folder, then back down into the 
folder will enable the upload to work. 

Bug 1399646 If a folder name contains an apostrophe, you cannot open that folder in the 
Web interface. 

Workaround: Remove the apostrophe from the folder name. 

Bug 1403302 Using theme search in the Advanced Find window causes the Web server to 
stop responding to requests. 

Workaround: Do not use theme searches. (Theme indexing is turned off by 
default in Oracle 9iFS.) 

Bug 1408308 Users cannot create a link to individual versions of a versioned document. 

Workaround: If you want to reference a particular version of a document, 
you can paste and create a copy, but you cannot have a reference.  

Bug 1416997 The tree frame gives unexpected results if a folder in the tree is renamed 
using a different protocol. 

Workaround: Refresh the browser. 

Bug 1480275 The File Contents criterion of the Advanced Find window allows you to 
specify a particular string to search on and its language. Some users may 
think they're specifying a language attribute to search on. 

Workaround: Use the Windows Utilities instead. 

Bug 1524432 Changing the renderer implementation for the WebDAV renderer stops the 
Web interface. 

Workaround: Do not subclass Renderer. Create a custom renderer.set. 

Bug 1604545 Using UTF-8 encoded *.js files causes a Web page error in Internet Explorer 
for Simplified Chinese. This is a known issue with some versions of  
Internet Explorer. 

Workaround: Use only Internet Explorer 5.5 (5.50.4134.0600) with 
Simplified Chinese systems. 



  第 2 章  Oracle Internet File System リリース・ノート 41 

Bug 1872138 Folder items are sorted uppercase, then lowercase. When listing the items in 
a folder, the item sort is case-sensitive, by name. 

Workaround: None. 

 

FTP Bugs 
The following table describes the known FTP bug and provides a workaround. 

 

Bug Number Description and Workaround 

Bug 1832626 Occasionally the Browser will stop responding when using Netscape as the FTP 
client to upload a file into Oracle 9iFS. This occurs when using Netscape as an 
FTP client and during a file upload using the drag-and-drop function through the 
Web interface. 

Workaround: Try again or use Internet Explorer as the FTP client. 

 

E-mail Bugs 
The following table describes the known e-mail bugs and provides workarounds when appropriate. 

 

Bug Number Description and Workaround 

Bug 1859056 Content searches will not return matches on binary attachments in e-mail 
messages.  

Workaround: None. Currently only text and HTML e-mail content and 
attachments are indexed.  

Bug 1197079 Occasionally, trying to delete several messages and expunge them at once using 
Netscape Messenger 4.7 causes the client to fail. 

Workaround: Retry the operation. If the error recurs, restart the client and delete 
messages in smaller groups. 

Bug 1248657 Mail sent from a machine that uses XFN instead of DNS does not always work. 
XFN is a federated naming service used instead of DNS. 

Workaround: DNS is required for Oracle 9iFS. 

Bug 1379886 It is not possible to remove folders named with non-ASCII characters using 
EUDORA 4.3.2. 

Workaround: Use another e-mail client, SMB, or the Web interface to remove the 
folder. 
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Bug 1380015 If a user name has non-ASCII characters, logging into the IMAP server may fail. 
This happens if the server character set is not set correctly. 

Workaround: Set the Oracle 9iFS server default character set to ISO8859-1 or the 
appropriate multibyte character set. 

Bug 1387952 An e-mail that originated from a PINE client is not viewable in the Oracle 9iFS 
Web interface. The body of the e-mail will not be displayed and instead a "404 
Document not found" error is reported. 

Workaround: The e-mail message can be viewed using any standard e-mail client 
suitably configured, and through Windows Explorer using Oracle 9iFS SMB. 

 

HTTP Bugs 
The following table describes the known HTTP bug and provides a workaround for it. 

 

Bug Number Description and Workaround 

Bug 1393110 In an Apache environment, servlet names exactly matching one or more of the 
first characters of the name of a top-level directory will cause the Web interface 
to fail. For example, if the name of the servlet is files, the presence of a folder 
named files will cause the Web interface to fail. 

Workaround: Do not create any top-level folder on Oracle 9iFS with the same 
first set of characters as the servlet name (by default, files). 

 

Oracle 9iFS Manager Bugs 
The following table describes the known Oracle 9iFS Manager bugs and provides workarounds when 
appropriate. 

 

Bug Number Description and Workaround 

Bug 1822898 When using OEM on Linux Intel, if you do not provide the host credentials for 
the root user when you start or refresh the domain (or in the OEM preferred 
credentials), OEM may list only the HTTP node and its related servers, even 
though you selected other servers to run. In addition, the OEM job to launch the 
Oracle 9iFS main node may fail with the following output:  
"$ORACLE_HOME/9ifs/bin/ifslaunchnode must be run as root." 

Workaround: Provide the Linux Intel root user credentials when launching the 
main node through OEM or in the OEM preferred credentials.  
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Bug 1753455 When you use Oracle 9iFS Manager to make a change in the protocol or server 
configuration, you will need to unload and reload the servers, not just stop and 
start the servers, before the change will take effect.  

Workaround: Unload and reload the servers after any changes.  

Bug 1847573 If you launch the Oracle 9iFS Dashboard from within OEM and have incorrect 
credentials in the OEM preferred credentials, the Dashboard will exit without any 
error message.  

Workaround: Set the preferred credentials to be the Oracle 9iFS schema name 
and password. Check the dashboard.log file in the 
$ORACLE_HOME/9ifs/log directory for more information. 

Bug 1857080 When invoking the Oracle 9iFS Dashboard from the command line instead of 
OEM, some messages are displayed on the terminal (standard output).  

Workaround: None. These messages may be safely ignored. 

Bug 1867608 In the Oracle9i OEM Console, Oracle 9iFS related online help appears in its own 
'Contents', 'Index', and 'Find' tabs, separated from the rest of the OEM online 
help.  

Workaround: None. 

Bug 1522235 When using Oracle 9iFS Manager in Spanish, Italian, Korean and Traditional 
Chinese character sets, some menus, tool-tips and buttons may show up in 
English.  

Workaround: None.  

Bug 1718014 Cannot add extended attributes that are named the same as SQL reserved words. 
You cannot name an attribute with SQL reserved words such as UNIQUE and 
SELECT.  

Workaround: Choose other names for the attribute. For more information and a 
list of reserved words, refer to the Oracle9i SQL Reference. 

Bug 1683035 On Linux Intel, the Property Inspector does not correctly re-size the "Categories" 
or "Relationships" pull-down splitter when using the mouse. As a result, 
categories and relationships can't be seen until the user manually clicks and pulls 
down the splitter.  

Workaround: Before navigating the Properties, Categories, or Relationships tabs, 
click the Properties tab twice, after which all splitters will be re-sized correctly. 
This step must be done only once per session.. 

Bug 1167418 The ACLs of DirectoryUsers cannot be changed in the Oracle 9iFS Manager. 

Workaround: Go to the Web interface and select the user in the Users list. Click 
Edit > Apply ACL to update the ACL. 
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Bug 1388097 Users and ACLs cannot be renamed in Oracle 9iFS Manager. 

Workaround: To rename an ACL, go to the Web interface, select the ACL in the 
ACL list and click Edit->Rename. Renaming a DirectoryUser requires a Java 
utility that can update the NAME attribute of the DirectoryUser. 
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